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Quick Overview of the Access User
Interface

1.

In this lesson, you will learn...

1. About the organization of the Access ribbon.
2. About the context tabs in the ribbon.
3. About the Quick Access Toolbar and how to customize it to your needs.
4. About the Navigation Pane.
5. About the objects and creation process.
6. About the Access work surface.
7. About the creation of databases using a wizard.

For this lesson, open the My Music Collection database located with your Webucator
class files at ClassFiles/OverviewoftheAccessUserInterface/Demos/Demo - My
Music Collection.accdb. If prompted concerning disabled content, click Enable
Content in the yellow banner.

Access Ribbon1.1

For this demo, we will open ../OverviewoftheAccessUserInterface/Demos/Demo -
My Music Collection.accdb. The tabbed area that spans the top of the Access window
below the title bar is called the ribbon. The ribbon holds the commands that you
can use to affect objects in Access. The commands available at any point in time
depend on the type of object you have selected and the current view mode.

The ribbon has five standard tabs: File, Home, Create, External Data, and Database
Tools.

A new feature is the Tell me what you want to do... (not available in the web app).
This feature shows you options and takes you to an exact command, executing it
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along the way. It also provides an opportunity to get help for a topic. The screenshot
below shows the results of a print search in the Tell me what you want to do...

.
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File

Selecting the File tab takes you to the Backstage, an area where file-level commands
can be accessed.

To return to the main Access window from the Backstage, click .

Selecting Info in the vertical menu on the left gives you access to the Compact &
Repair and Encrypt with Password utilities.

New lets you create a new database by selecting from among numerous database
templates. To start a desktop database from scratch (as we will later in this course),
you would click the "Blank desktop database" template.
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Open lets you locate an existing database and open it. Selecting the Recent option
on the Open page shows you the database files you have used most recently. You
can click on a file name to open it. Notice when you hover over items in the file list
that a horizontal push pin appears to the right of the file name. Clicking the push
pin will pin the file name to the list so that it always appears in the list unless you
subsequently unpin it. Selecting the This PC option on the Open page lets you open
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the current folder or recently used folders to search for database files. Alternatively,
you can click Browse to navigate to a file.

Save is available if you go to the Backstage when changes to database objects have
not been saved. Clicking Save saves changes to database objects and returns you to
the main window.

Save As lets you save the current database in a different file format or with a different
name, or it lets you save a database object as a different file type (e.g., save an Access
report as a PDF).

You may have the need to save a database as an older format in order to keep the
format compliant with pre-existing environments.

By saving a database as a template, you will be able to easily replicate the
functionality and structure of a database. This is helpful when you have several
similar databases to create and roll out ensuring that once an end-user is used to the
functionality of one database, they will easily take to the other new ones without
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any further training. You may also reuse query, report and forms assuming the table
and field names remain the same.

Print offers options for printing the currently selected database object.
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Close closes the current database file but leaves the Access program open.

Account shows information about your product installation.
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Options opens the Access Options dialog box where you can configure settings for
Access and for the current database. The Access Options dialog box includes many
settings to personalize your experience as you work with Access and to configure
the current database according to your needs.

The left pane of the Access Options dialog box lists the categories of settings that
you can control. Highlight a category to see the settings available for that category
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in the right pane. Make any changes needed in the right pane. When you are ready
to apply the changes, click OK to save the changes and close the dialog box.

Home

The commands on the Home tab are arranged in six groups:

• Views - Switch among the views available for the current object.
• Clipboard - Cut, copy, and paste data or objects. Apply formatting from one

object on other objects.
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• Sort & Filter - Sort data. Apply quick filters or filter by form.
• Records - Maintain records. Add a total row. Perform spell check.
• Find - Find records that match your criteria. Perform search and replace.
• Text Formatting - Change font styling, text justification, text color, bulleting.

Create

The commands on the Create tab are arranged in six groups:

• Templates - Create a database object from a template.
• Tables - Create a table in Datasheet view or Design view.
• Queries - Create a query using a wizard or in Design view.
• Forms - Create a form using a wizard or in Design view. Create specialized

forms.
• Reports - Create a report using a wizard or in Design view. Create labels using

a wizard.
• Macros & Code - Add and organize macros to automate tasks.

Wizards throughout Access will allow you to ease into the creation process as the
Wizards lead you through the choices and options available. Most objects offer one,
if not several, wizards to choose from.

External Data

The commands on the External Data tab are arranged in two groups:

• Import & Link - Import data from a variety of data sources.
• Export - Export data from the database in a variety of formats.
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Database Tools

The commands on the Database Tools tab are arranged in six groups:

• Tools - Compact and repair the database.
• Macro - Access the Visual Basic for Applications editor. Run a macro.
• Relationships - Define relationships between tables in the database.
• Analyze - Analyze database objects for performance. Analyze tables for

unnecessary data duplication.
• Move Data - Prepare the database for sharing with others.
• Add-Ins - Manage optional add-in features.

In this course and in the advanced course, we'll use commands from all the ribbons;
however, our primary focus in this course will be on tools available in the Home
and Create tabs.

Contextual Tabs

As you work with objects in Access, you may notice that additional tabs become
available in the ribbon depending on the object you are working with and the view
mode you are in. For example, when a table is open in Datasheet view, a Table
Tools tab with two sub-tabs, Fields and Table, is visible.

Tabs like these are called contextual tabs. They provide specific additional tools for
the object you are currently working with.
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Quick Access Toolbar1.2

The Quick Access Toolbar is a customizable set of icons that typically displays
above the ribbon to give you easy access to common commands such as Save, Undo,
and Redo.

To use a command in the Quick Access Toolbar, simply click its icon. You can
customize the toolbar to show whichever commands you prefer.

To add more common commands to the Quick Access Toolbar:

1. Click the drop-down arrow at the right end of the Quick Access Toolbar to
open the Customize Quick Access Toolbar menu.

Note that commands already on the Quick Access Toolbar have a check mark
to their left in the menu.

2. From the menu, select the command you want to add to the toolbar. Its icon is
immediately added to the toolbar.

To remove a common command from the Quick Access Toolbar:
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1. Click the Quick Access Toolbar drop-down arrow.
2. From the menu, select the check-marked command you want to remove from

the toolbar. Its icon is immediately removed.

Any command that is available in Access can be added to the Quick Access Toolbar.
To do so, you use the Access Options dialog box.

To customize the Quick Access Toolbar using the Access Options dialog box:

1. Click the Quick Access Toolbar drop-down arrow and select More
Commands....

The Access Options dialog box opens with the Quick Access Toolbar category
already selected.
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2. In the left list box, locate and highlight the command to add to the Quick Access
Toolbar.

3. Click Add. The command moves to the right list box.
4. Click OK. The command is added to the Quick Access Toolbar.
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Object Navigation Pane1.3

Along the left side of the main Access window is the Navigation Pane. The
Navigation Pane shows the database objects that are part of your database
application. Use the pane to open the database objects you want to work with.

If you need additional work area, the Navigation Pane can be collapsed by clicking
the shutter bar button in the upper right corner of the pane.
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To restore the pane, click the shutter bar button on the collapsed pane.

The Navigation Pane can be filtered by category and by object type. To do so, click
the drop-down arrow at the top of the pane and select the desired category from the
Navigate To Category section of the drop-down menu. After you select a category,
you can open the drop-down menu again and select the group to filter by in the lower
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section of the menu. The groups change depending on the category selected. The
pane title changes to match the group you select.

The Navigation Pane provides easy access to your database objects. To open an
object, double-click on its name in the Navigation Pane.
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Access Work Surface1.4

When you open an object from the Navigation Pane, the object appears in a tab on
the Access work surface. The work surface is where you perform most of the tasks
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related to creating and maintaining a database. You can open multiple objects on
the work surface at the same time. Each object appears in a separate tab.

To make an object active so you can work with it, select its tab. To close an object,
select it and then click the X at the far right end of the tab.

Object Overview1.5
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Tables

Tables are the storage vessel for your data. Careful planning and arrangement of the
fields that make up each table with consideration of the relationships between them
make for a well rounded relational database design. If this foundation is prepared
well, the rest of the objects that you create will be a smooth process.

Queries

Queries are designed to pull the relevant data form each table to create a recordset
which can be used as the basis of you reports or to analyze the data in a meaningful
way.

Forms

Forms present an opportunity to create a user interface for data entry that may be
customized to fit your audience needs. Forms may be based off of Tables for data
entry, or Queries for on screen reports and analysis.

Reports

Reports are used to create a Query or Table data that presents well in a print format.
They may be customized and also saved out as a PDF file type for on screen viewing.

Macros and Modules

Macros and modules allow you to automate database functions and to provide
additional functionality. Macros are built by selecting from a list of actions and
combining actions to produce the effect you want. Modules are collections of
functions and procedures written in the Visual Basic for Applications (VBA)
language.

Macros and modules are beyond the scope of this course; however, the advanced
course will demonstrate how to use basic macros to automate forms and reports.

Process Overview1.6

The general process of building a database begins well before we approach Access
to build the corresponding objects that make up the database. We need to step back
and research the needs and resources available. Creation of a plan will help to keep
you and your team on track as well as provide the visuals to explain the logic to
others that will interact with your database. We will delve deeper in to the research
and planning phases later in the course making sure you have a full understanding
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of the process start to finish regardless of your responsibilities in the project. The
full understanding helps you better communicate with others on the team.
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Getting Around the Access EnvironmentExercise 1
15 to 25 minutes

Using the "Exercise - My Music Collection" database located at Class
Files/OverviewoftheAccessUserInterface/Exercises/Exercise - My Music Collec
tion.accdb, perform the following tasks:

1. Pin the database file to the Recent files list.
2. Add the Quick Print icon to the Quick Access Toolbar.
3. Filter the Navigation Pane so that only tables appear in the list.
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Exercise Solution

To pin the database file to the Recent files list:

1. Select the FILE tab.
2. Select Open and Browse.

3. LocateClassFiles/OverviewoftheAccessUserInterface/Exercises/Exercise - My Music Collec
tion.accdb and click Open.
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4. In the Recent files list, locate Exercise - My Music Collection.accdb and hover over the file
name until you see the horizontal push pin. Click the push pin The file moves above the list
separator and is denoted with an upright push pin.
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To add the Quick Print icon to the Quick Access Toolbar:

1. Return to the Home tab. If you're in the Backstage, click .
2. Click the Quick Access Toolbar drop-down arrow and select Quick Print from the drop-down

menu. The icon is added to the toolbar.

To filter the Navigation Pane so that only tables appear in the list of objects:
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1. In the Navigation Pane, click the drop-down arrow in the pane title bar to open the drop-down
menu. In the Navigate To Category section of the menu, ensure that Object Type is selected.

2. Click the drop-down arrow again and select Tables in the Filter By Group section of the
menu.
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Create a Database Using a Wizard1.7

When creating a new database, you have choices to use pre-made databases. These
can be found on the internet, or many organizations may provide custom databases
for their employees.
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1. File > New > Search for the topic.

2. Single click upon the database of choice.
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3. Choose a location and a name for the database. Click Create.

4. You may be presented with a Welcome screen depending on your template
choice. Click Get Started.
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5. The database is now ready for use.
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The databases available may not always be exactly what you need, but they are a
good start. Tables and other objects may be added or deleted as needed.

Conclusion1.8
In this lesson, you learned:

• To find your way around the Access environment.
• To customize elements such as the Quick Access Toolbar and Navigation

Pane to suit your preferences.
• To open objects on the Access work surface so that you'll be ready to learn

more about the creation process.
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Queries5.

In this lesson, you will learn...

1. About queries and query views.
2. How to create a simple query.

In this lesson, we'll focus on the database objects you can use to retrieve data from
tables (queries).

For this lesson, open files located with your Webucator class files at ClassFiles/In
tro_Queries/Demos/. If prompted concerning disabled content, click Enable Content
in the yellow banner.

Queries5.1

Definition and Purpose

A query is a way for you to describe what data you want to see and then have Access
fetch that data and either return it to you or perform some action on that data. Queries
are especially powerful because they can pull together data from multiple related
tables and other queries. Queries are frequently used as the basis for data entry forms
and for reports.

Types

The two main types of queries supported by Access are select queries and action
queries.

Select Queries

A select query retrieves data from your database. Select queries can be used to
perform calculations.
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Action Queries

An action query can add, change, or delete records in your database. An important
caveat about action queries is that they cannot be reversed. You may want to consider
backing up your data before performing an action query.

The types of action queries available in Access include:

Make table - Creates a new table using data from other tables in the database.

Append - Adds records to a table.

Update - Makes changes to records.

Delete - Removes records from a table.

Views

Similar to tables, queries have a Datasheet view and a Design view. In addition,
queries have a SQL view that allows you to view the query statements that Access
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interprets to make the queries work. In fact, if you know SQL (Structured Query
Language) you can write your own query statements directly in the SQL editor.

Open ClassFiles/Intro_Queries/Demos/Demo - My Music Collection - Simple Select
from Multiple Tables.accdb.

To switch among views for a query, select the Home tab, click the drop-down arrow
below the View icon, and select the view you want from the drop-down menu.

Datasheet View

The Datasheet view for queries resembles the Datasheet view for tables in most
respects.

In fact, the procedures for selecting data, filtering, sorting, navigating, searching,
adding new records, and editing records are the same.
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To run a select query, you can simply open it in Datasheet view.
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Design View

The work of putting your data request into terms that Access can understand occurs
in query Design view.

The query tab in Design view consists of two sections. The top section holds
representations of the tables and queries you want to extract data from.

The bottom section is where you specify the data you want the query to return, how
you want it sorted, and criteria for filtering the data.

The Property Sheet allows you to set unique attributes for each item.
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We will explore Design view in more depth in the advanced course.
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SQL View

As you set up a query in Design view, Access builds the equivalent SQL statements.
You can see what those statements look like in SQL view by right clicking and
choosing SQL View.

Working with SQL statements is beyond the scope of this course; however, viewing
the SQL code and familiarizing yourself with the syntax will deepen your
understanding of how queries work.

Select Queries5.2

At the heart of every kind of query is a select query.

Select queries can return a subset of fields from a single table or can aggregate data
from multiple tables.

To create a simple select query showing data from a single table:Open ClassFiles/In
tro_Queries/Demos/My New Database - Simple Select.accdb.

1. Open the database.
2. On the Create tab in the Queries group, click Query Design. The Show Table

dialog box opens.
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3. Highlight the table to perform the query on and click Add.

4. Click Close.

5. In the table, double-click the field names you want to add to the query grid.
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6. On the Query Tools: Design tab in the Results group, click Datasheets view.
The results display in a datasheet.

7. Click Save.
8. In the Save As dialog box, type a name for the query and click OK.

Page 169 of 258Version: 1.0.1. Printed: 2016-03-04.

Queries

EVALUATION COPY 

 
 

Unauthorized Reproduction or Distribution Prohibited



To run a query after you've saved it:

1. Locate the name of the query in the Navigation pane.

2. Double-click the query name.

To write a select query to pull together data from multiple tables: Open ClassFiles/In
tro_Queries/Demos/Demo - My Music Collection - Simple Select from Multiple
Tables.accdb.

1. Open the database.
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2. On the Create tab in the Queries group, click Query Design. The Show Table
dialog box opens.

3. Highlight the tables to add to the query and click Add.

4. Click Close.
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5. In the tables, double-click the field names you want to add to the query grid.

6. On the Query Tools: Design tab in the Results group, click Datasheet view.
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The results display in a datasheet.

7. Click Save.
8. In the Save As dialog box, type a name for the query and click OK.

Select Queries with Criteria5.3

You can select very precise result sets by applying selection criteria to a select query.
Selection criteria let you include or exclude data based on the requirements you
specify.

To create a select query with selection criteria: Open ClassFiles/Intro_Queries/De
mos/Demo - My Music Collection - Select Query with Criteria.accdb.

1. Open the database.
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2. On the Create tab in the Queries group, click Query Design. The Show Table
dialog box opens.

3. Highlight the tables to add to the query and click Add.

4. Click Close.
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5. In the tables, double-click the field names you want to add to the query design
grid.
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6. In a column for a field you want to limit results by, enter a value or expression
in the Criteria row. To enter more criteria for a single field, use the or rows
below the Criteria row. For examples of acceptable criteria, search Access
help for "examples of query criteria" and see the section on logical operators
that follows this section.

The result set will include records that satisfy at least one of the criteria specified
for a field. In our example, the result set will include records where the artist
name starts with "C" OR where the artist name is "Beatles".
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7. Enter criteria for other fields as desired.

The result set will include only the records that satisfy all the columns. In our
example, the result set will include records where the artist name starts with
"C" AND the format is "Compact disc" OR records where the artist name is
"Beatles" AND the format is "Compact disc".

8. On the Query Tools: Design tab in the Results group, click Datasheet view.
The results display in a datasheet.

9. Click Save.
10. In the Save As dialog box, type a name for the query and click OK.

Logical Operators5.4

When specifying selection criteria, it's not always convenient (or possible) to list
all the acceptable criteria values. Usually it's better to write logical expressions to
describe the criteria. This is where logical operators come in. Logical operators
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describe how we want our criteria evaluated. In conjunction with operators, we can
use wildcard characters, symbols such as asterisk (*) that substitute for other
characters or strings of characters.

The following table lists common logical operators with examples and explains their
use.

ReturnsExampleOperator

Items that start with "C".Like C*Like

Items that end with "C".Like *C

Items that contain "C".Like *C*

All items except those that start with
"C".

Not Like C*Not Like

All items except those that end with
"C".

Not Like *C

All items except those that contain "C".Not Like *C*

Items that are blank.Is NullIs Null

All items that are not blank.Is Not NullIs Not Null

Items that match one of the values in
the list.

In (Arizona, New Mexico,
Texas, Oklahoma)

In

Items that don't match one of the values
in the list.

Not In (Arizona, New
Mexico, Texas,
Oklahoma)

Not In

Items that fall between 200 and 400.Between 200 and 400Between and

All items that don't fall between 200
and 400.

Not Between 200 and 400Not Between
and

Items that are less than 200.< 200<

Items that are less than or equal to 200.<= 200<=

Items that are greater than 400.> 400>

Items that are greater than or equal to
400.

>= 400>=

You can create very specific selection criteria by combining logical expressions.
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Group and Total with Queries5.5

In a query, you will often need to summarize data. The totals row uses Group By to
better structure your data, then choose from options such as SUM to create subtotals.
(sample below uses tables from ../ExtraDatabase/SampleCompany.accdb)
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Totals Row with Group By

1. Click on Design > Show/Hide > Totals.

2. Make sure you have your fields arranged left to right in importance. Then
choose Group By to start the process.

3. Choose SUM for the numerical data.

4. The results return the Names, then itemName with a sum of each item number
and price.
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5. Remember, order matters as when we remove the Name field, the results will
now focus on the unique itemNames.

6. See the results below, a summary of each item with the Sum of number and
price.
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Creating Select QueriesExercise 9
15 to 25 minutes

In this exercise, you will create a query recordset of uncleared transactions for the
Bank Register database from the ClassFiles/Intro_Queries/Exercises/Bank Regis
ter.accdb.
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Exercise Solution

First, we will create a select query to select the uncleared transactions and then we'll change it to
a make table query.

1. Open the database.
2. On the Create tab in the Queries group, click Query Design.
3. In the Show Table dialog box, highlight "Transactions".

4. Click Add.
5. Click Close.
6. In the table, double-click * to add all fields in the table to the query.
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Hint: Double-clicking * is a quick way to add all the fields in a table to your query. You can
still add a field from the table to use as selection criteria, just make sure to clear the field's
Show check box so that the field doesn't appear twice in your results.
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7. In the table, locate and double-click the Cleared field to add it to the query design grid.

8. Clear the check box in the Show row for the Cleared field. (We don't want the Cleared field
to appear twice in our table.)
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9. In the Criteria row for the Cleared field, type "False". (We want the table to show only
transactions that are not cleared.)

10. On the Query Tools: Design tab in the Results group, click Datasheet view.
11. View your results.

12. Switch back to Design view and click Save.
13. In the Save As dialog box, type a name for the query and click OK.
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Conclusion5.6
In this lesson, you learned:

• About the Access queries.
• About the views available for working with queries.
• About select queries with criteria.
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